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Tutorial
Welcome to MM-BOX, a powerful program which allows you to create interactive productions 
containing images, sound, animation, CD audio, pictures, video and  text. It's easy to use and quick
to learn, so you  won't  spend hours struggling with programming manuals before you get a 
multimedia production on the screen.
MM-BOX has been designed for non-technical people to prepare their own multimedia prorductions
in a short time and without too much trouble. 
MM-BOX productions are made up of one or more pages containing the presentation elements: 
push buttons, text boxes, rectangles, rounded rectangles, lines, circles, ellipses and Video 
Windows. Video Windows allows you to include full motion video and 2,000,000 color still video 
images in your productions.
MM-BOX elements carry an actions list. When clicking on any element, the actions will be 
performed one after the other. This adds a touch of class to your productions.
Actions allow you to:

 Show or toggle anything on the page
 Add pauses and delays between actions
 Add time-out generated actions
 Enable, disable, freeze and unfreeze video from analogue sources
 Go to any page
 Apply fade effects during page navigation
 Play an audio track from an audio CD on your CD-ROM
 Play an animation created in Autodesk Animator, Animator Pro or 3D Studio
 Play a digital video clip in PLV, AVI (Video for Windows®) or Indeo® (RTV2.1) formats
 Play a MIDI sequenced sound file
 Play a waveform (digitized) sound file
 Play a section of a laser disk or a video cassette

Good-bye slide shows and welcome to the world of Interactive Multimedia!

This section is a tutorial which takes you step by step through three productions. 
The first part of the tutorial shows you how to set up a presentation with several screens, add  
boxes of text in bullet points, create buttons to take you from page to page and display the bullet 
points in order.
The second part shows you how to create a fully featured multimedia production, including audio, 
animation and interactivity.
The third part shows you how to create a simple slide presentation using the MM-Video board to 
display 2,000,000 color images. This section is only relevant if you have an MM-Video board or 
compatible installed in your system.
After working through these three examples, you'll be familiar enough with the basics of MM-BOX 
to work with the Reference manual. 
MM-BOX isn't difficult to use, even if you've never used a computer before.  After working through 
this tutorial, you'll be designing and creating your own multimedia prductions much faster than you 
expect. Screens consist of text boxes, graphics and buttons. Creating, adjusting and changing 
each element is quick and easy. 

It's normal to make mistakes. Nobody gets it right first time. If you activate a button and it doesn't 
do what you wanted when you press it, it's because you've given it the wrong instruction. Going 
back and changing things that don't work properly is part and parcel of creating anything that works
on a computer. It's called debugging. Everybody has to do it. The more familiar you get with MM-
BOX, the fewer mistakes you'll make.
Don't be frightened of trying out your own ideas, even when you're working through the tutorial. 
Nobody's going to come along and tell you you've done it wrong because you felt like inserting a 
few pictures or sticking in a couple of extra buttons. 
Make yourself a cup of tea, switch on and enjoy yourself.
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Before you start
MM-BOX and Windows should already be installed on your computer. If not, get your company's 
computer person to do it for you. If you feel comfortable with it, the Installation section of this book 
tells you how to do this.
When you sit down to start working through the exercises, the Program Manager screen should 
already be displayed on your computer. If it's not there, load Windows first. Again, if you're on your 
own, have a look in the Reference section to find out how to do this. To take advantage of the 
multimedia features of MM-BOX (CD, digital video, sound and animation) you should have the 
relevant Windows drivers for these devices already installed. MM-BOX installs during setup the 
necessary drivers for the playback of Autodesk FLI and FLC files.

Windows
MM-BOX runs under a graphical user interface called Microsoft Windows. If you're already familiar 
with Windows, skip this section. 

The mouse
Windows uses a mouse, the little plastic thing the size of a cigarette packet with two or 
three buttons on it. Moving the mouse around on your desk moves the cursor on the 
computer screen. 
With MM-BOX you mostly use the left button, so 'clicking the mouse button' means clicking 
the left mouse button.
There are several ways of using a mouse.

Pointing
Point to something on the screen by moving the cursor over the object.

Clicking
Click on an object under the cursor by pressing a mouse button and releasing it 
immediately. Objects and items on pull down menus are usually selected by clicking.

Double-clicking
You can also double-click on an item. This is as simple as it sounds. Click the mouse 
button twice in quick succession. Double-clicking is often used to open or start something 
happening on the screen.

Ctrl+ double-clicking
In some parts of the tutorial, you will be asked to "Ctrl+double-click" on an element. This 
means holding the control key (marked 'Ctrl' on your keyboard) and clicking the left mouse 
button twice in quick succession.

Dragging.
Move the cursor over an object, press down the mouse button and hold it down, then move
the mouse. The object you've selected is dragged across the screen. Release it by 
releasing the mouse button. 

Sizing
MM-BOX elements are resized by dragging the edge of the element you wish to size, while
holding down the shift key. We call this Shift+Drag.

Pull Down Menus
The screen has a row of words along the top, like File and Edit. This is the menu bar. All 
Windows applications have a menu bar along the top.
To display the contents of each menu, click on the menu title. The menu is opened. Move 
the cursor down the menu. Each item is highlighted as the cursor passes over it. To select 
an item, click when it is highlighted.

Status Bar
The status bar is located in the bottom part of the MM-BOX main window. It displays useful 
information while you create your presentation. The status bar displays information on the 
name of the page, the selected element and other relevant information.

Dialog Boxes
Dialog boxes are the panels with which you "communicate" with Windows programs. They 
can include radio buttons (a small circle with a dot inside if the button is on), check boxes 
(a small square with an X inside if the box is "checked"), edit boxes (in which you can type 
text or numbers), list boxes (from which you can select an item) and combo boxes (similar 
to list boxes, but with a "drop-down" feature). Some dialog boxes may include other type of 
controls.
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Getting Started
The Program Manager screen should be displayed on your monitor.
Move the cursor to the icon that looks like a small PC monitor, labelled MM-BOX, and double-click 
to start the program.

The main MM-BOX screen is displayed.

The line of words along the top of the screen is the main Menu.
Main Menu

File contains options which allow you to save and print your presentation.
Edit contains options for copying, deleting, pasting and editing elements.
Page contains commands for  moving to new pages, creating pages and backgrounds, and
searching for a piece of text.
Presentation allows you to switch between the Creation and Presentation modes and 
contains commands for how to start the presentation.

Setup allows you set up the page size and contains commands for communicating with 
any video equipment, such as a laser disk player.
Palette allows to display the Character, Paragraph, Color, Grid and Element palettes. It 
also allows you to display the quick menu icon bar.

The Status Bar
The status bar contains various items which display information about what you're doing. 
Background ID tells you which background is used 
by the current page you can create as many backgrounds as you want each one with a 
different color.
CR/PR tells you in which operation mode 
you are working. CR stands for Creation Mode, and PR for Presentation Mode. Creation 
Mode is the mode in which you add  pages, elements and actions to your presentation. 
Presentation Mode in the mode in which you 'run' your presentation. Buttons and other 
elements with action lists will execute these actions as you click in them.
Page tells  you which page name and 
number of your presentation you're in, and how many pages you have created. When you 
start there is only one page, so Page 1-1 [Main] is displayed. When you create a page, 
you are asked to name it. The first page is always named Main.
Selection [ ] tells you what is currently selected 
on the page. At the moment nothing is selected.

Ready to Start - Tutorial 1

When you have the MM-BOX window displayed on the screen, select File, New and type TUTOR1 
and press [enter]. 
Double-click anywhere in the work area.
The Add Element dialog is displayed. 

This allows you to add the basic elements which make up your presentation screens, a Text box, 
Button, Line or Shape, Picture, Video Window or Background color. 
Start by changing the background color.

 Click on Background Color. It becomes highlighted.
 Click OK.

The Color Tray is displayed. 
Select a color by clicking on one of the small color squares.
The background color becomes your selected color. Click Exit to close the Palette.
You will create three pages, each containing a title and four bullet points with text, which will be 
switched on one at a time. To make life easier, create the bullet points, title and text boxes all on 
the same page, then copy the page.
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Creating the page title.
 Double-click on the top of the page to display the Add Element window.
 Select Text and click OK. A small text box appears in the spot you double-clicked the 

mouse. This box will contain the page title.
 Double-click inside the text box. The Edit Text Element window is displayed. 
 Drag the Edit Text window away from the Text Box so you can see what's happening 

there when you create the title.
 Click on Font Palette. The Character window is displayed. This is where you 

determine the font, size and style of the text for the title.
 Click on the small arrow next to Font to display the fonts. Scroll the fonts by holding 

down the mouse button with the cursor on the arrows at the top and bottom of the scroll 
bar. Click on the font of your choice (for titles it is better to use a 'sans-serif' font like 
Arial, for example). The name of the selected font is displayed in the small box.

 Select the font size in same way. A big size like 24 point will do. 
 Click on style. 

 Four font styles, bold, italic, underlined and strike-out, are displayed. The standard 
style is plain. Select as many of the styles as you want. For example, your text could be 
bold, italic and underlined. Clicking on the style selects it. Clicking again on the same 
style deselects it. 

 You can click the Apply button at any time to see the text changing to the selected 
font and style.

 When you are satisfied, click OK.
 The box already contains the word 'Text'. Delete it by pressing the  backspace key 

and type Title 1.
 You don't want the title to appear adjacent to the side of the box, so click on 

Paragraph.
 The Paragraph window is displayed.

 Click Center in the Alignment box.
 Click OK.
 Select Shadowed border style.
 Click OK.
 Select the Palette menu, and click on Color Tray.

When creating a text box, the color you choose for the border is also applied to the text. 
 Click on a color for the Border (and text).

 Select another color for the inside of the box by selecting Fill and clicking on another 
color.

The box is then displayed with the text and attributes you defined. It's not the correct size. 

 Adjust the size of the box by clicking on the text box while holding down the Shift key 
on the computer keyboard, and dragging the mouse. Release the mouse button when 
the box is the right size.

 Move the box by positioning the cursor inside it and dragging.
Now is a good time to save what you've done so far. Click on File on the menu bar. Move 
the cursor down the menu, highlight Save and click.
You should save what you've done every fifteen minutes or so. Then if you accidently 
delete everything, you won't lose all your work. If you're familiar with computers, you've 
probably already learned this the hard way.

Create a button
Create a button which will also serve as the first bullet point.

 Double-click with the cursor in an empty spot of the work area to display the Add 
Element window, or select Add Element from the Edit menu.

 Select Button and click OK. A button appears on the screen.
 Position the cursor over the button and double-click to display the Edit Button window.
 Delete the 'Button' caption with the backspace key and click OK. The presentation 

window appears with the textless button. 
 Size the button to an approximate square by holding down Shift and dragging the 

corner of the button towards its centre.
 Drag the button into position. Leave enough space to position a text box to the right 

and four more buttons below it. 
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 Display the Palette menu and select Grid. Turning the grid on makes any objects on 
the screen snap to the nearest position on a grid. This makes positioning buttons and 
boxes much easier. The number indicates size of the grid in screen units.

 Click in the small box to turn the grid on. A cross appears in the box.
 Click OK.

Copy the button
Create four more 'bullet point' buttons on this page. The easiest way to do this is to copy 
the button you've already created.

 Click on the button to make sure it's selected. The button number appears in the 
status bar when selected.

 Display the Edit menu and click on Copy.
The button is now copied onto the Windows clipboard.

 Display the Edit menu again and select Paste.
The new button is pasted on top of the old button, so the screen still looks the same.

 Drag the new button from the top of the old button and drop it in its new position.
 Select Paste again and drag the third button into position. 

Repeat the procedure for the last two buttons. Notice the button number in the status bar 
changes each time you select a new button. 

Create Text boxes for buttons
Each button will have a box of text by the side. The easy way to create five text boxes is to 
do the same thing you did for the buttons, create one and copy it four times. You already 
created a text box for the screen title, but the boxes next to the buttons will look better in 
different colors, so create a new box, position it then copy and paste it.

 Double-click in the window, not in the title or over a button, to  display the Add 
Element box.

 Click on Text then click OK.
 Double-click in the Text box to display Edit Text Element window.
 Enter the text, Button 1. Select the font, style and size as before. 

 Open the paragraph box and position the first Line to be at 0.1.  Open the Color Tray 
and select Border and Fill colors as before.

The new text box is displayed.
 Drag the box to the correct size and position it, as you did with the title and buttons.
 Copy, Paste,  and drag four more text boxes into position, the same way you did with 

the buttons.
Change the Text

You now have five text boxes, but the text in each box is the same.
 Double-click in the second Text box.
 Move the cursor to right of Text box 1.
 Press the Backspace key to delete 1 and type 2.
 Click OK.

Repeat the procedure for boxes 3, 4 and 5, adding a new number to each box.
Create a navigation button         

Create a button that allows a user to move to the next page of the presentation by clicking 
on it.

 Double-click in the window to display the Add Element window.
 Select Button and click OK.

A new button appears on the screen. 
 Position the cursor over the new button and double-click on the button to display the 

Edit Button screen.
 Delete the existing caption and type >>. 
 Click OK. The button appears with its new caption.

 Size and move the button in the usual way.
You've created the new button; now you need to tell it what to do when it's pressed. This is 
known as Adding an Action.
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 Check on the status bar to make sure the button is selected. If not, click on it.
 Select Add Action on the Edit menu (or double-click on the button while holding down 

the Ctrl key). The Actions window is displayed.
 Select Go to Page and click Apply. This tells the button that the action it causes is to 

go to another page.
 The Go To Page dialog box is displayed. This tells the button which page to go to.
 You want this button to take you to the next page, so click on Next Page. To make 

things interesting, select the Wipe Right effect at Normal speed.

 Click Apply.
The Action Window is displayed again.. The button now has its action attached. You can  
check it by clicking on the Edit Actions button. It will display the action you just entered, 
something like "Wipe Right Normal to NEXT PAGE".
Repeat the process to create another button, labelled '<<',  whose action takes you to the 
Previous Page.
You've added two action buttons to the page, one to take you to the next page, the other to 
take you to the previous page.

Toggle the Text Boxes
When running the presentation, it would be better to display the text boxes next to the 
bullet points one at a time, by clicking on the appropriate button when you're ready to 
display the next bullet point. To do this, you need to add actions to each of the buttons.

If you'd added actions to these buttons before copying the page, you would have got in a 
muddle, because each action is tied to a particular text box on a particular page.

 Press the F2 key to return to Creation mode.

 Click on the text box next to the button you want to switch the text box on and off with.
Note the number of the text box on the status bar. You need to know this when you 
define the button's action. 

 Select the top Button.
 Select Add Action under the Edit menu.
 Click Toggle. Click Apply.

 A List of objects is displayed. This contains a list of all the objects on the page, 
including the text box the button will control.

 Select the field with the number of the text box next to the button. 

 If you've forgotten which text box it is, take a guess and click on Point to. The text box
you've selected will blink on the page. If it's the wrong text box, try again until you locate
it. When you find the right text box, click Apply.

 Click Exit on the Action window.
Change to Presentation mode (press F2, remember?) and try out your button.
If you click it once, the text box next to it should disappear. Click again and it reappears.
Return to Creation mode and repeat the process for all the buttons on the screen.

Set the page for start-up
When you leave a page of your presentation all the text boxes will be on display. When you
return to that page for another presentation, you want the boxes to be concealed. Do this 
by adding an action to the page itself.

 Go to Presentation mode and hide the text boxes by clicking on their buttons.
 Return to Creation mode
 Select the page by clicking on it.
 Select Add Action. The Page Actions window is displayed.
 Click on Restore Page Contents on the On Leaving Page box. A cross appears in the 

box to show it is selected.
 Click on Take Snapshot of Page.

 This causes whatever is in your snapshot to be displayed when you enter the page. 
Because you concealed the text boxes before you took the snapshot, they will be 
concealed every time you turn to that  page.

 Click OK.
 Save it. 

Repeat the procedure for the other two pages. Add actions to the buttons next to the text 
boxes on the remaining pages.
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Adding a picture to a page
Brighten up you presentation by adding a logo to the page.

 Display the Add Element window by double-clicking when the cursor is over the page.
 Select Picture.
 Click OK.
 The Select a picture window is displayed.

A list of picture files is displayed under Files.
 Select the LOGO.BMP picture by clicking on the filename.

 Click OK.

The picture is placed into the work area. Position it by dragging. 

Copy the Page
 Select the page by clicking on it. The status bar indicates  Selection: [page Main]
 Copy  and Paste the page in the same way as you copied and pasted windows and 

buttons, simply select Copy and Paste from the File menu.
 When you paste the new page you will be asked to enter a page name. Type 

BulletPage2 and click OK.
 The title on page 2 says the same as the title on page 1, so double-click in the text  

box and change Title 1 to Title 2.
 Paste another page, name it BulletPage3 and change the title to Title 3.

You've created three pages with titles, buttons next to text boxes and two action buttons to 
move from page to page. It's time to see if what you've done so far works.
MM-BOX has two modes, Creation and Presentation. All your work so far has been in the 
Creation mode. To run the presentation you need to change to Presentation mode.

 Select Presentation mode under the Presentation menu. You can also press the F2 
key. This key acts as a toggle between Presentation and Creation modes. It also hides 
the menu and status bar when in Presentation mode, to make your presentations look 
good.

 Click on one of your page navigation buttons to move to the next or to the previous 
page. 

Move back and forth through the presentation. Well done!

My first Multimedia presentation - Tutorial 2
In order to go through this Tutorial you will need to have your MM-AUDIO sound board or other 
MPC compatible sound board installed in your system. Also, make sure that the Windows drivers 
for your sound board are also properly installed. Refer to the MM-AUDIO User's Guide on the 
Installation section on how to install the Windows drivers if you haven't done so yet.
The Program Manager screen should be displayed on your monitor.
Move the cursor to the icon that looks like a small PC monitor, labelled MM-BOX, and double-click 
to start the program.
When you have the MM-BOX window displayed on the screen, select File, New and type MMTUT2 
and press [enter]. 
Creating the "start" page

 Double-click on the page and select Background color.
 Select Fill and select the light-gray color.
 Double-click on the page and select Text. 
 Double-click on the newly created Text element.
 Select the border style to shadowed and click Apply.
 Click the Font palette button, select the Helv font with 24 points size and click OK
 Click the Paragraph, select Justification Center and click OK.
 In the Text edit box type 'Multimedia Presentation' and press Ctrl+enter (to add 

another line to the text)
 Type 'by John Smith'. (For flattery's sake, type your name...)
 Click OK.
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 Resize the text element by shift+dragging the mouse, until the full text is visible.
 Drag the text field to the center of the page.
 Select Palette menu, Color Tray.
 Select Fill  in the Color Tray, and select the lightest yellow color.
 Select Border and select a dark blue color.

Now let's create the START button. The START button will be the one that will start your 
first multimedia presentation.

 Double-click on the page, below the text element we created previously and select 
Button from the Elements dialog box. 

 Double-click on the newly created Button element.
 Click the Font palette button, select the Helv font with 12 points size, bold and click 

OK
 In the caption box, type 'START'
 Click OK
 Drag the button to a convenient place below the text element.

If you have done it properly, your screen should look like this:

Creating the Multimedia Page
 Select Page menu, New Page or use the Ctrl+N shortcut on the keyboard.
 Type MMPAGE as the name for the new page and click OK

In the new page we will start by creating four buttons. The first two to play and stop a 
sound file and the other two to play and stop an animation file.

 Double-click on the page, select Button and click OK.
 Select Edit, Copy or use the Ctrl+Ins keyboard shortcut instead. A copy of the button 

will be held in the Windows clipboard.
 Select Edit, Paste, or use the Shift+Ins keyboard shortcut instead, to paste the 

button. Repeat this step another two times. Now you will have four buttons in the 
screen, although it seems that you have only one... This is because the four buttons are
stacked exactly one on top of the other!

 Drag each of the four buttons so one is below the other and are situated closer to the 
left hand side of the page. You can set the Grid as explained in the previous tutorial if 
you wish.

Adding audio and animation buttons
 Using the Edit Element command from the Edit menu, or by double-clicking in each 

of the buttons, change their captions to 'AUDIO ON', 'AUDIO OFF', 'ANIMATION ON', 
and 'ANIMATION OFF' respectively.
Now, we need to add the proper actions to each of the buttons.

Adding the WAVE actions
 Double-click on the AUDIO ON button, while holding the Ctrl key on your keyboard 

(Ctrl+double-click), or click in the button and select 
Add Action from the Edit menu.

 Select WAVE and click Apply.
 Click on LOAD and select the wave file SAMPLE1.WAV from the MMBOX2 directory 

(or from the directory you chose when installing the MM-BOX software), and click OK.
 Select WAVE and click Apply again.
 Select the SAMPLE1.WAV from the list box (it is probably already selected, because 

is the only one there) and click on PLAY. A dialog box with the parameters of the wave 
file will be displayed. Click OK. (To find out more about the usage of the options in this 
dialog box, consult the reference section of this guide).

 To check that the actions have been added to the action list of the button, click on the 
Edit Actions button.

 It will show something like:
WAVE "LOAD SAMPLE1.WAV"
WAVE "PLAY SAMPLE1.WAV"
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 Click Exit
We have added the actions for the AUDIO ON button. Let's add the action for the AUDIO 
OFF button.

 Double-click on the AUDIO OFF button, while holding the Ctrl key on your keyboard 
(Ctrl+double-click), or click in the button and select Add Action from the Edit menu.

 Select WAVE and click Apply.
 Select the SAMPLE1.WAV from the list box  and click UNLOAD.
 The action list for this button should now have an WAVE "UNLOAD SAMPLE1.WAV" 

action. You can check that by clicking the Edit Actions button.
Now let's give it a try:

 Press the F2 key (the key that toggles from Creation mode to Presentation mode). 
The Menu and status bar will be hidden and now the buttons are activated.

 Click the AUDIO ON button. After 2 or 3 seconds (it's loading the Wave file) the music
will start to play. 

Note: 
If you receive an error message, it means that you have not yet installed the Windows 
driver. Please refer to the Installation section of your MPC compatible sound board on how 
to do so. If you don't get an error message and the music is not playing, check that your 
speakers are connected properly to your sound board and the volume is set to an audible 
level.

 Clicking the AUDIO OFF button will stop the music.
Now is time to add the actions to the ANIMATION ON and OFF buttons

Adding the ANIMATION actions
 Press the F2 key to go back to Creation Mode.
 Double-click on the ANIMATION ON button, while holding the Ctrl key on your 

keyboard (Ctrl+double-click), or click in the button and select Add Action from the Edit 
menu.

 Select ANIMATION and click Apply.
 Click on LOAD and select the wave file MIKMM.FLC from the MMBOX2 directory (or 

from the directory you chose when installing the MM-BOX software), and click OK.
 Select ANIMATION once again and click Apply .
 Select the MIKMM.FLC from the list box and click PLAY. A dialog box with the 

parameters of the wave file will be displayed. Click OK.
 To check that the actions have been added to the action list of the button, click on the 

Edit Actions button.
 It will show something like:

ANIMATION "LOAD 
MIKMM.FLC"

ANIMATION "PLAY 
MIKMM.FLC"

We have added the actions for the ANIMATION ON button. Let's add the action for the 
ANIMATION OFF button.

 Double-click on the ANIMATION OFF button, while holding the Ctrl key on your 
keyboard (Ctrl+double-click), or click in the button and select Add Action from the Edit 
menu.

 Select ANIMATION and click Apply.
 Select the MIKMM.FLC from the list box  and click UNLOAD.
 Click OK.
 The action list for this button should now have an ANIMATION "UNLOAD 

MIKMM.FLC" action. You can check that by clicking the Edit Actions button if  you 
wish.

Now let's try both buttons at once. 
 Press the F2 key to toggle to Presentation mode. The Menu and status bar will be 

hidden and now the buttons are activated.
 Click first the AUDIO ON button and immediately click on the ANIMATION ON button. 

Welcome to Multimedia!!
 Click on both the AUDIO OFF and ANIMATION OFF buttons to stop.
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Don't get carried away, there is still work to do. Now that we have the buttons working let's 
make this more elegant. For that we will introduce a new action called the Click action. The
Click action means exactly that: clicking in another element or elements. For that let's 
create a new button, (double-click on an empty place of the page, remember?), change it's 
caption to 'PLAY !' and place it centered in the bottom side of the MM-BOX window (near 
the bottom window edge).

 Double-click on the PLAY! button, while holding the Ctrl key on your keyboard 
(Ctrl+double-click), or click in the button and select Add Action from the Edit menu.

 Select Click and click Apply.

 Move the Add Action dialog box from its position to the rightmost part of the screen, 
so we can see what we are doing. Do that by dragging the mouse while pointing to the 
top part of the dialog box.

 A list of the elements in the page will be shown, together with their ID numbers. You 
should have..., let's see..., 5 buttons, yes. 

 We need to add an action to click on both the AUDIO ON and ANIMATION ON 
buttons. 

 Find out which one is the AUDIO ON by using the Point to button. When you have 
find it, click Apply.

 Select Click once again and click Apply.
 Find out which one is the ANIMATION ON by using the Point to button. When you 

have find it, click Apply.
The PLAY! button now should have the Click button 1, Click button 3 actions (or similar) on 
it's action list. Create a new button with a 'Stop!' caption, and guess what, add to it the 
actions to click on the AUDIO OFF and ANIMATION OFF buttons. You can do it on your 
own, believe me...!
And 2 minutes later .... 

Now that we have the two 'master' buttons created, we can tidy up our page and hide the 
AUDIO ON, AUDIO OFF, ANIMATION ON and ANIMATION OFF buttons. Buttons as any 
other element are still 'working' and active even if they are hidden from view. By hiding 
these buttons we will have a working page but with less buttons cluttering our presentation.

 Select Element List from the Edit Menu.
 Using the Point to technique select the AUDIO ON, AUDIO OFF, ANIMATION ON 

and ANIMATION OFF buttons one at the time and click the Hide button. They will 
disappear like magic, although we know they are still alive and kicking. A small h will be 
prefixed to indicate they are hidden. We can always Show them if we need to change 
something in their action lists.

To strengthen our belief that "hidden buttons are still alive", press F2 and click on the 
PLAY!  and STOP! buttons. Press F2 again to go back to 
Creation Mode when you are convinced.
That's all very well, we got our buttons working as we wanted, but what about making it all 
play automatically as we enter this page from our main page...? ...OK, let's do it.

Click on the PLAY! and STOP! buttons and write down their ID numbers. The ID 
numbers are always displayed on the status bar, after you select an element by clicking 
on it.

 Double-click on an empty place of the page, while holding the Ctrl key on your 
keyboard (Ctrl+double-click), or click on an empty place of the page and select Add 
Action from the Edit menu.

 The Page Actions dialog box will be displayed.
 In the Entering the Page section, check the Click on element box and select the 

button ID corresponding to the PLAY! button.
 In the Leaving the Page section, check the Click on element box and select the 

button ID corresponding to the STOP! button.
 Click OK.
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Now lets  go to our first page. You can achieve this by pressing Ctrl+Up arrow or by 
selecting First from the Page menu.

 Double-click on the START button, while holding the Ctrl key on your keyboard 
(Ctrl+double-click), or click in the button and select Add Action from the Edit menu.

 Select Goto Page and click Apply.
 Select the page MMPAGE, Wipe Right, Fast and click Apply.
 Press F2 to switch to Presentation Mode.
 Click the START button. 

Voilà! If every thing was done properly, after the wipe is finished the animation and sound 
will play together. The only thing left is to add a new button to the MMPAGE to return to the
first page. That we leave you to do later, after you have taken a short but well earned 
break.

Creating a Slide Show - Tutorial 3
The final section of the tutorial shows you how to create a simple slide-show, using the five 2 
million color sample pictures supplied with your program.  This tutorial is only relevant if you have 
the MM-VIDEO video overlay board or C&T PCVIDEO compatible (like the Video Blaster) installed 
in your system. If you don't have one installed, skip this section. Contact our sales department if 
you are interested in getting an MM-Video board for your system. The telephone numbers of our 
sales offices can be found in the back side of the cover page of this guide.

 Start MM-BOX as before.

 Create a new file, and give it a name.
 Select a medium page. The blank screen is displayed. Click twice on the left mouse 

button to display the Add Element window.
 Select Background Color, click OK and select a color from the palette.
 Select the Add Element window again and choose Video Window. Click OK,

A black square appears on the screen. This is where the slides will be shown.

 Display the Color Tray, select a color and click on Border at the bottom of the palette. 
The pictures you are loading contain over 2,000,000 colors, so they will be loaded into the 
video buffer. You need to check that the MM-Video board is initialized.

 Click on Initialize MM-Video Board on the Setup menu.
A message is displayed telling you the initialization is OK. If the initialization failed, tell the 
computer person or consult the Configuring the MM Video Board section on the MM-Video 
User's Guide.

 Hold down the Shift key on the computer keyboard and double-click with the left 
mouse button with the cursor in the Video Window. The Action window is displayed.

 Select Video Picture and click Apply. The Select Video Picture window is displayed.

 Select APPLES.MMP and click OK. The Actions window is displayed. You want the 
picture to be displayed for two seconds before the next picture is displayed, so click on 
Delay then click on Apply.

 The delay window is displayed. Enter 2 seconds and click OK.
 The Actions window is displayed again. Click Exit. The work area is displayed again, 

but the picture isn't in the box. Go to Presentation mode to view the picture.
 Click on the VideoWindow. The video picture is displayed.

The picture doesn't fit into the box. Return to Creation mode, hold down Shift and size the picture 
by dragging the corner of the Video Window. When you release the mouse button the picture 
disappears.
Go back to Presentation mode to check that the picture fits. The other pictures in your slide show 
are the same size, so you won't need to adjust the size of the Video Window again. 
Adding the other pictures

 Hold down the Shift key and double-click with the left mouse button with the cursor in 
the Video Window. 
The Action window is displayed.

 Select Video Picture and click Apply. The Select Video Picture window is displayed.
 Select COFFEE.MMP and click OK. Add a 2 second delay, the same as for the first 

picture.
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 Select Video Picture again, from the Actions window, and add BIKINI, ISLAND and 
COUPLE, all with 2 second delays.

 Click on Edit Actions in the Actions window. A list of the pictures and their actions is 
displayed.

If one of the pictures is in the wrong position, highlight it and move it by clicking on Move 
Up or Move Down. Similarly, you may delete an action by selecting it and clicking on 
Delete.

Adding a "Start" button
You will now add a button to start the slide show.

 Double-click with the cursor in the work area and add a button.
 Double-click on the button, change the text to Start Show and size it.

 Hold down Shift  and Double-click over the button to display the Actions screen.
 Select Click and click on Apply. The list of objects is displayed.

 Click on Video Window and click Apply. Clicking the button now starts the 
presentation.

 Switch to Presentation mode and preview the slide show.

This is the end of the Tutorial. Well done. Don't expect to remember everything you've done. The 
more presentations you create, the more familiar you'll get with MM-BOX. Try some of your own 
ideas out. The rest of this book tells you everything you need to know about the aspects of MM-
BOX not covered in the Tutorial. You already know the basics, how to put text and pictures on the 
screen, give instructions to buttons, set delays, change screens etc. The rest of the book simply fills
in the details. You've done the difficult bit already.
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Quick Reference
Mouse

Click Select element (or page)
Right-Click Un-select element (or page)
Double-Click (on the page) Add element
Double-Click (in element) Edit element
Ctrl+Double-Click (in element) Add Action to element
Ctrl+Double-Click (in the page)) Add Action to page
Shift+Drag Resize Element

Keyboard
Function Keys

F1 Help
F2 Toggle Presentation/Creation 
Modes
F5 Search
F10 Menu
F11 Set work area to center of screen
Ctrl+F2 History
Shift+F2 Go Back to last visited page

Other Keys
Ctrl+0 Open
Ctrl+S Save
Ctrl+X Exit
Shift+Del Cut
Ctrl+Ins Copy
Del Delete
Ctrl+Right Arrow Next Page
Ctrl+Left Arrow Previous Page
Ctrl+Up Arrow First Page
Ctrl+Down Arrow Last Page
Ctrl+N New Page
Ctrl+V New Background
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